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ABSTRACT

With the proliferation of electronic loads and the increased competition in deregulated electric utility industry and due to rapid growth of nonlinear loads as well as interconnectedness in power system, power quality monitoring has become increasingly important. It has become an essential tool for improvements in the availability of power, for preventive and predictive maintenance, for ensuring equipment performance, and for sensitivity assessment of process equipments to several disturbances.

In the present study, graphical programming of LabVIEW software has been utilized to develop power quality analyzer and also to monitor power quality disturbances (like voltage sag, swell, interruption, frequency variation, etc.) using ADVANTECH DAQ Card (inserted in PC). Use of virtual instrumentation for the measurement and monitoring power system improves the performance and reliability of the system. Monitoring helps to identify power quality problems and minimize losses in the production process as well as increase plant productivity. Virtual instrumentation saves the extra cost, time and energy that are incurred while setting up traditional instrumentation systems. It is a latest form of modern measurement/monitoring technology where all types of measurements are done on front panels created on PC screen.
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CHAPTER- I
INTRODUCTION
1.1 INTRODUCTION:
Power quality is an issue that has become increasingly important to electricity consumers at all levels of usage. Sensitive equipments are now commonly used in both the industrial /commercial sectors and the domestic environment. Occurrences effecting the electricity supply that were once considered acceptable to electricity companies and users are now often considered a problem to the users of everyday equipment. Power quality disturbances can range from short interruptions to long interruption, magnitude variations and flicker. In order to evaluate and identify the disturbances and their origin, power quality monitoring has become an indispensable tool that utilities and customers must use.
POWER QUALITY DISTURBANCES:

Power quality is the set of parameters defining the properties of power supply delivered to the users in normal operating conditions in terms of continuity of supply and characteristics such as harmonic content in the waveform, variations in voltage (magnitude, frequency, and symmetry), transient disturbances and flicker etc.

Power Quality can be defined as the measure, analysis, and improvement of the bus voltage to maintain a sinusoidal waveform at rated voltage and frequency. Ideally the power signal waveforms supplied by the utility are not clean 50 Hz sine wave as specified by the national standards or system specifications. It can generally deviate at least in the following ways.

· A voltage dip is a reduction in the RMS voltage in the range of 0.1 to 0.9 pu (retained) for duration greater than half a mains cycle and less than 1 minute. Often referred to as ‘sag’ caused by faults, increased load demand and transitional events such as large motor starting.
· A voltage swell is an increase in the RMS voltage of 1.1 to 1.8 pu for a duration greater than half a mains cycle and less than 1 minute caused by system faults, loads switching and capacitor switching.

· A transient is an undesirable momentary duration of the supply voltage or load current transients, which are generally classified in two categories: Impulsive and Oscillatory.
· Harmonics are periodic sinusoidal distortions of the supply voltage or load current caused by nonlinear loads. Harmonics are measured in integer multiples of the fundamental supply frequency.

· Distorted voltage or current waveforms containing periodic distortions of a sinusoidal nature that are not integer multiples of the fundamental supply frequency are termed as inter-harmonics.
· Flicker is a term used to describe the visual effect of small voltage variations on electrical lightning equipment. The frequency range of disturbances affecting lightning appliances, which are detectable by the human eye, is 1-30HZ.

· Voltage imbalance is defined as a deviation in the magnitude and/or phase of one or more of the phases of a three-phase supply, with respect to the magnitude of the other phases and the normal phase angle (120 deg).

· Frequency deviation is a variation in frequency from the nominal supply frequency above/below a predetermined level normally plus or minus 1%.

· A transient interruption is defined as a reduction in the supply voltage, or load current, to a level less than 0.1pu for a time of not more than 1minute. Interruption can be caused by system faults, system equipment failures or control and protection malfunctions.
· An outage is defined as interruption that has duration lasting in excess of 1 minute.

CAUSES OF DISTURBANCES IN POWER SYSTEMS:
Due to the power system impedance, any current (or voltage) harmonic will result in the generation and propagation of voltage (or current) harmonic and effects the entire power system. Fig.1.1 illustrates the impact of current harmonics generated by a nonlinear load on a typical power system with linear loads.
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Fig 1.1 Disturbance propagation in Power System

1.2 SOURCES RESPONSIBLE FOR POOR POWER QUALITY:
POWER ELECTRONIC DEVICES:

The non-linear loads such as adjustable speed drives, electronic ballasts for fluorescent lamps, and power supplies for welding machines have become sources of poor power quality. Often the nonlinearity of the load results in the generation of harmonics that cause overheating of electrical equipment and distort the voltage wave.
IT AND OFFICE EQUIPMENT:

IT equipment power supplies consist of a switched mode power supply (SMPS) and are the cause of a significant increase in the level of 3rd, 5th and 7th harmonics voltage distortion in recent years.

ARCING DEVICES:

Electric arc furnaces, arc welders and electric discharge lamps are all forms of electric arcing devices. All arcing devices are sources of harmonic distortion. Arc welders commonly cause transients in the local network due to the intermittent switching and therefore some electronic equipment may require protection from the impulsive spikes generated.
LOAD SWITCHING:
The effect of heavy load switching on the local network is a fairly common problem causing transients to propagate through to other ‘electrically close’ equipments.

LARGE MOTOR STARTING:

In starting mode of operation, induction machines draw current which can be as high as six times the normal rated current which has the effect of causing voltage dip on the local network.
EMBEDDED GENERATION:

Increased levels of embedded generation predicted in the future are likely to have an effect of poor power quality. An increased level of embedded generation will lead to increased fault current level in the feeders. This increased fault level is one of the major concerns while considering embedded generation issues.

SENSITIVE EQUIPMENT:

If it were not for the use of increasing levels of sophisticated equipment which tends to be more sensitive, power quality would not have become such an issue in recent years.
STORM AND ENVIRONMENTAL RELATED DAMAGE:

Lightning strikes are a cause of transient over-voltages often leading to faults on the electric supply networks. High winds and storm conditions cause widespread disruption to the supply networks. Snow and ice building up have a severe effect on the reliability of overhead lines.
1.3 METHODOLOGY:

In the present study, graphical programming of LabVIEW software has been utilized to develop power quality analyzer and also to monitor power quality disturbances (like voltage sag, swell, interruption, frequency variation etc.) using ADVANTECH DAQ Card (inserted in PC).Use of virtual instrumentation for the measurement and monitoring power system improves the performance and reliability of the system. Virtual instrumentation saves extra cost, time and energy that are incurred while setting up traditional instrumentation system. It is a latest form of modern measurement/monitoring technology where all types of measurements are done on front panels created on PC screen.

In real situations data can be collected with the help of data acquisition technique and given to PC through specific interfacing device. Then this raw data can be processed or analyzed by using VI software, LabVIEW. The VI software is powerful, and can acquire, analyze and present any signal efficiently and hence this can be very helpful for devising methods to avoid their harmful effects.
1.4 CONSEQUENCES OF POOR POWER QUALITY:
Poor electric power quality has many harmful effects on power system devices and end users. Even if failures do not occur, poor power quality and harmonics increase losses and decrease the lifetime of power system components and end users devices. Some of the main detrimental effects of poor power quality include the following.

· Harmonics add to the rms and peak values of the waveform. This means equipment could receive a damagingly high peak voltage and may be susceptible to failure.
· There are adverse effects from heating, noise, and reduced life on capacitors, surge suppressors, rotating machines, cables and transformers, fuses and customer equipments as well as malfunction of controllers and protective devices such as fuses and relays.

· Additional losses of transmission lines, cables, generators, AC motors and transformers may occur due to harmonics.

· Failure of power system components and customer loads may occur due to unpredicted disturbances such as voltage and / or current magnifications due to parallel resonance and Ferro-resonance.
· Utility companies are particularly concerned that distribution transformers may need to be derated to avoid permanent failure due to overheating (caused by harmonics).

· Inter harmonics may occur which can perturb ripple control signals and cause flicker at sub-harmonic levels.
· Harmonic instability may be caused by large and unpredicted harmonic sources such as arc furnaces.

· Harmonic, sub-harmonic, and inter-harmonic torques may arise.
1.6 POWER QUALITY MEASUREMENT TOOLS:

Power quality monitoring is the process of gathering, analyzing and interpreting raw measurement data into useful information. The process of gathering data is usually carried out by continuous measurement of voltage, current and frequency over an extended period. Obviously, we would like to monitor locations at virtually all locations throughout the system to completely understand the overall power quality. However, such monitoring may be prohibitively expensive. Fortunately, taking measurements from all possible locations is usually not necessary since measurements taken from strategic locations can be used to determine characteristic of the overall system.
1.6.1 PCC (POINT OF COMMON COUPLING):
It is the bus closest to a polluting load from which other customers are supplied. In a radial system it is rather straightforward to find PCC. An example is shown in the Fig. 1.2 where it corresponds to metering point but this is not always the case.
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Fig. 1.2 Definition of PCC in Radial System
Development of Power Quality Analyzer built on virtual instrumentation technology can remotely monitor any power quality disturbances sustained by the user unlike power quality measurement tools (like harmonic analyzer, disturbance analyzer, true rms multi-meter, oscilloscope, flicker meter).
Post acquisition analysis performed on the collected data can be programmed according to our requirement like Power Quality Analyzer in this dissertation which is not possible in the case of above mentioned tools.
Nowadays there are several types of commercial tools in the market that can be used to monitor power quality problems or to perform power management studies. However they are usually expensive.

1.7 POWER QUALITY MONITORING STANDARADS:
Standards are very important in the area of power quality monitoring. Power quality levels must be defined consistently and characterized using the same methods if they are going to be compared from one site to another and from one system to another .IEEE 1159 is the IEEE working group that coordinates the development of power quality monitoring standards. The existing IEEE 1159 provides general guidelines and definitions for monitoring power quality much of this work is coordinated with IEC activities so that the monitoring requirements can be more consistent internationally. This section describes the most important IEEE and IEC standards. IEEE 1159 guide for power quality monitoring:

After publication of the basic monitoring guidelines, working groups were established for development of more advanced guides for power quality monitoring.

The IEEE 1159.1 working group is developing guidelines for instrumentation requirements associated with different types of power quality phenomena like sampling rate requirements, synchronization, A/D sampling accuracy, and number of cycles and sample.

The IEEE 1159.2 working group is developing guidelines for characterizing different power quality phenomena. Single task force is being coordinated with the development of an international standard for characterizing power quality variations with monitoring equipment-IEC 61000-4-30.

The IEEE 1159.3 working group is defined an interchange format that can be used to exchange power quality monitoring information between different applications.
[image: image4.emf]
Table 1.1 Suggested Monitoring Thresholds from IEEE 1159
1.8 OBJECTIVES OF THIS DISSERTATION:

Objective of this dissertation is
1) First objective is to develop a single indicator, designated power quality factor (PQF), in the range between zero to one, which integrally reflects the power transfer quality of a general three-phase network feeding unbalanced nonlinear loads. PQF varies between 0 to 1. For a balanced loaded network, with sinusoidal currents and voltages and zero phase displacements yield an ideal PQF 1. A low value of PQF indicates a low degree of utilization of the power capacity of the source and/or a high level of harmonic and/or a high degree of unbalance between the phases.
2) Second objective is monitoring of power line disturbances. The PQM is configured as virtual instrument, which automatically indicates any sort of disturbances such as impulse, voltage sag, voltage swell, interruption and frequency variation.
1.9 DISSECTION OF DISSERTATION:
The material of this dissertation has been organized in seven chapters. The contents of the chapters are briefly outlined as indicated below.

Chapter-1 discusses on the definition of power quality, sources for poor power quality, typical power quality disturbances, effects of poor power quality, power quality measurement equipments and standards and gives a brief objective of this thesis.
Chapter-2 discusses on Literature Review.
Chapter-3 discusses power quality monitoring system.
Chapter -4 discusses about the implementation of first objective i.e. power quality analyzer using virtual instrumentation and its notable features.
Chapter-5 discusses about the implementation of second objective i.e. acquiring data using ADVANTECH DAQ CARD and analyzing acquired data for indicating various power quality disturbances.
Chapter-6 Results and Discussions
1.10 CONCLUSION:

This chapter gives brief introduction about power quality and need for monitoring power quality, brief idea about disturbance propagation in power system and discusses typical power quality disturbances and their characteristics, gives idea about power quality measurement tools and discusses objective of this thesis and gives brief outline of the project design.

CHAPTER II

LITERATURE REVIEW
2.0 INTRODUCTION

In order to understand the power quality problems better, comprehensive monitoring and data collection of power quality events is important. Monitoring system can serve as a vital diagnostic tool and help to identify the cause of power quality disturbances and even possible to identify problem conditions before they cause interruptions or disturbances.

Power quality monitoring is the process of gathering, analyzing, and interpreting raw measurement data into useful information. The process of gathering data is usually carried out by continuous measurement of voltage, current, frequency, time, etc. over an extended period. The process of analysis and interpretation has been traditionally performed manually, but recent advances in signal processing and artificial intelligence fields have made it possible to design and implement intelligent systems to automatically analyze and interpret raw data into useful information with minimum human intervention.

2.1 HISTORICAL PERSPECTIVE OF POWER QUALITY MONITORING:
Monitoring of power quality began from 1920 onwards. One of the earliest power quality monitoring instruments is lightning strike recorder developed by General Electric in 1920’s. This instrument makes an impulse-like mark on strip-chart paper to record a lightning strike event along with its time and date of occurrence. The data were more qualitative then quantitative, making the data interpretation rather difficult.

Significant development on power quality devices was not made until 1960’s when Martzloff developed a surge counter that could capture a voltage waveform of lightning strikes. The improvement of this device over its predecessor was that the recorded data were quantitative (voltage waveforms) as opposed to qualitative (marks on strip charts).
By the mid-1960s, limitations of power quality devices relating to the trigger mechanism and the preset frequency response were well understood. Many engineers consider that the first generation of power quality monitors began in the mid-1970s when Dranetz Engineering Laboratories (now Dranetz-BMI) introduced the Series 606 power line disturbance analyzer. The output of these monitors was text-based, printed on a paper tape. The printout described a disturbance by the event type (sag, interruption, etc.) and voltage magnitude. These monitors had limited functionalities compared to modern monitors, but the triggering mechanics were already well developed.

Second-generation power quality instruments debuted in the mid-1980s. This generation of power quality monitors generally featured full graphic display and digital memory to view and store captured power quality events, including both transients and steady-state events. Some instruments had a capability of transmitting data from a remote monitoring site to a central location for further analysis. Second-generation power quality instruments virtually had perfected the basic requirements of the triggering mechanism. Since the occurrence of a power quality disturbance is highly unpredictable, data must be continuously recorded and processed without any dead time.

By the mid-1990s, the third-generation power quality instruments emerged. The development of the third-generation power monitors was inspired in part by the EPRI DPQ project. This generation of monitors was more appropriate as part of a complete power quality monitoring system, and the software systems to collect and manage the data were also developed but some difficulties were faced in managing a large system of monitoring power quality. By the turn of the century, the internet had made many-to one data communication far simpler. Modern systems conveniently transport data and information to wherever it is needed, and apply clever algorithms to extract useful information and present it to an untrained audience who can use the information to make decisions, which is the ultimate goal of monitoring.

Although Instruments have been developed that measure a wide variety of disturbances, a number of different instruments may be used depending on the phenomena being investigated. Basic categories of Power Quality Measurement instruments that were developed are Wiring and grounding test devices, Multimeters, Oscilloscopes, Disturbance analyzers, Harmonic analyzers, Spectrum analyzers, Power Quality analyzer, Combination disturbance and Harmonic analyzers, Flicker meters, Energy monitors, Infrared meters, Electric field meters and Static electricity meters. All power quality measurement instruments that are described above are designed to collect power quality data. Some instruments can send the data over a telecommunication line to a central processing location for analysis and interpretation. However, one common feature among these instruments is that they do not possess the capability to locally analyze, interpret, and determine what is happening in the power system. They simply record and transmit data for post processing. An emerging trend in power quality monitoring practice is to collect the data, turn them into useful information and disseminate it to users. All these processes take place within the instrument itself. Thus, a new breed of power quality monitor was developed with integrated intelligent systems to meet this new challenge. This type of power quality monitor is an intelligent power quality monitor where information is directly created within the instrument and immediately available to the users. A smart power quality monitor allows engineers to take necessary or appropriate actions in a timely manner. Thus, instead of acting in a reactive fashion, engineers will act in a proactive fashion.

2.2 Development History of LabVIEW and its importance:

In recent years, the rapid development of micro-electronics technology, computer technology, network communication technology and software technology promote the rapid development of virtual machines technology. In labVIEW environment, real time power quality monitoring can be developed using Virtual Instrumentation concept. This is done with data acquisition system, which can transmit the measured signal any far-away place via guided or unguided media without distorting the original signals.

Virtual Instrumentation is an interdisciplinary field that merges sensing, hardware, and software technologies in order to create flexible and sophisticated instruments for control and monitoring applications. The concept of virtual instrumentation was born in late 1970s, when microprocessor technology enabled a machine’s function to be more easily changed by changing its software. The flexibility is possible as the capabilities of a virtual instrument depend very little on dedicated hardware. A history of virtual instrumentation is characterized by continuous increase of flexibility and scalability of measurement equipment. Nearly all of the instrument control programs were written in BASIC, because it had been the dominant language used with dedicated instrument controllers. It required engineers and other users to become programmers before becoming instrument users, so it was hard for them to exploit potential that computerized instrumentation could bring. Therefore, an important milestone in the history of virtual instrumentation happened in 1986, when National Instruments introduced LabVIEW 1.0 on a PC platform. LabVIEW introduced graphical user interfaces and visual programming into computerized instrumentation, joining simplicity of a user interface operation with increased capabilities of computers. Today, the PC is the platform on which most measurements are made, and the graphical user interface has made measurements user-friendlier. As a result, virtual instrumentation made possible decrease in price of an instrument. As the virtual instrument depends very little on dedicated hardware, a customer could now use his own computer, while an instrument manufacturer could supply only what the user could not get in the general market.
Virtual instrumentation combines mainstream commercial technologies, such as the PC, with flexible software and wide variety of measurement and control hardware, so engineers and scientists can create user defined system that meet their exact application needs. With Virtual instrumentation, engineers and scientist reduce development time, design higher quality products, and lower their design costs.
Virtual Instruments is basically used for displaying test or measurement data collected by the external device on instruments like panels on a computer screen. Thus Virtual Instrumentation uses a general purpose computer to mimic real instruments with their controls and displays.

The virtual instrument technology platform for the development of power quality monitoring system is flexible, easy to upgrade, able to overcome the traditional test and measurement system shortcomings, such as a single function and the complexity of the upgrade. Their functions are chosen by users and can be extended or modified according to users requirements in contrast with traditional instrumentation (multimeters, oscilloscopes etc.) where the functions are vendor defined by hardware.

2.3 LITERATURE SURVEY ON POWER QUALITY MONITORING USING LabVIEW:

Phang Yoke Yin and M. V. Chilukuri [1] developed a computer based data acquisition system that provides real-time monitoring of voltage and current at the customer’s point of common coupling (PCC). Any power quality disturbances sustained by the user throughout the monitoring period were detected and recorded on remote PC. Post acquisition analysis was performed on the collected data.

Yong Yang Xiaofeng Wang Chunling Chen [2] designed a new proposal of real-time power quality monitoring and analysis platform based on virtual instruments technology which aims at the key issues that affecting the quality of rural power network. From steady-state to transient-state, this article discusses the typical algorithms of harmonic analysis, voltage deviation and unbalance in three-phase, voltage swells and dips, voltage fluctuation, transient oscillation and the theory of power quality disturbances detection based on Hilbert phase-shifting.

Qiu Tang, Zhaosheng Teng, Siyu Guo and Yaonan Wang [3] designed a multifunctional Virtual power quality monitoring system and implemented in LabVIEW environment. S-transform is introduced and applied to perform time-frequency analysis on power quality disturbances. The root mean square (RMS) value, the waveforms of three-phase voltage and current, the harmonic components, the total harmonic distortion(THD) and S transform analysis waveforms of the three-phase voltage and current signals can be calculated and displayed in the system. Furthermore, the remote transfer of measured results is implemented using the AppletVIEW Toolkit in LabVIEW adopting a B/S framework. Measurement results show the feasibility and validity of the system.

Daniel Sharon, Juan-Carlos Montaño, Antonio López, Manuel Castilla, Dolores Borrás, and Jaime Gutiérrez [4] developed a single indicator [i.e., the power quality factor (PQF)] in the range between 0 and 1 to integrally reflect the power transfer quality of a general three-phase network feeding unbalanced nonlinear loads. The prominent power quality aspects considered are the following: 1) the voltage and current harmonic levels; 2) the degree of unbalance; and 3) the phase displacement factor in the different phases at the fundamental frequency.

Yong-June Shin, Edward J. Powers, Mack Grady and Ari Arapostathis [5] developed new transient power quality indices based on a signal processing technique, time-frequency analysis. Based on the time-frequency distribution of a transient disturbance, a set of time-frequency based power quality indices are developed. Instantaneous disturbance energy ratio, normalized instantaneous disturbance energy ratio, instantaneous frequency, and instantaneous K-factor are suggested for transient power quality assessment. Time-frequency based power quality indices allow one to quantify the effects of transient disturbances with high-resolution and accuracy.

Yang Huping and Bi Zhipeng [6] designed and forwarded the power quality parameters monitoring system based on the newest technology of the field of measurement and control. Now the Virtual Instruments introduced frequency, effective value and three-phase unbalance.
H.E Wenhai [7] developed a new noise test system based on virtual instrument technology which comprises the testing technology, the computer technology and the network technology. In this new system, the sound card of personal computer is used as data acquired card (DAQ card) for acquiring noise signals. So the total test system is more economical. During testing, noise signals are acquired and processed simultaneity by this system. User can obtain the information of the acquired noise signals in time domain and frequency domain. It is known from the actual testing that the test efficiency and precision both are enhanced because of the use of this new system.
Masoud Ali Akbar Golkar [8] described types of power quality variations types and presented the methods of characterizing each type with measurements are presented. Then, advances in power quality monitoring equipment and tools for analyzing power quality measurement results are described. The increased amount of data being collected requires more advanced analysis tools.

Alex Mc Eachern [9] discussed about roles of Intelligent Systems in Power Quality Monitoring: Past, Present, and Future.
Patricio Salmerón, Reyes S. Herrera, Alejandro Pérez Vallés, and Jaime Prieto [10] proposed two indices, a three-phase total demand distortion index and a total unbalance index. In addition, it develops an easy way to characterize the time-varying data to simplify their representation. The exposed procedures are applied to the data registered from an electrical power system, to show the performance of the proposed methods.

Gabriel Gasparesc [11] developed a virtual instrument for generation of disturbances which affect power quality.

B. P. Alencar, J. I. Gomes Filho, R. A. Melo, and R. P. S. Leão [12] designed flicker meter using labVIEW based on IEC 61000-4-15.

S. K Bath, Sanjay Kumra [13] simulated and measured power waveform distortions using labVIEW to know exact amount of harmonics, transient impulses and noise distortion in the system, so that it is possible to take appropriate actions to reduce their harmful effects.

Nermeen Talaat, W. R. Ibrahim George and L. Kusic [14] developed two intelligent techniques that perform power quality classification functions. These techniques are based on wavelet analysis, subtractive cluster algorithms and Artificial Neural Networks (ANN). Many signals are generated to simulate different types of power quality phenomena then wavelet analysis is applied to these signals. Different feature extraction methods are proposed to reduce the amount of processed data which dramatically improves the performance of the proposed PQ classifier compared to other techniques proposed elsewhere. The extracted features are then used to train different ANNs.

T.Lin, and A.Domijan [15] proposes method to overcome the limitations, deficiencies and difficulties of the practical application of power quality indices and measurement techniques in common use, through a set of three new indices. The paper summarized the time varying waveform distortion in an intuitive, comprehensive and highly efficient way. Moreover, developed a novel time frequency transform for the first time to continuously and accurately monitor the instantaneous frequencies and amplitudes of specific signal components in the non-stationary power disturbance, and then update the PQ indices in real time.

Savina Natalia Victorovna [16] suggested the method of integrated assessment of electric power loss caused by poor power quality in power supply systems based on the structural analysis of loss. It was demonstrated, that in power supply systems with low observability power loss, caused by power quality distortions, should be estimated considering the degree of completeness and validity of source information. Presented results of the study concerning the influence of power quality upon metrological and technical power loss were presented.
2.4 CONCLUSION:
An extensive literature review of power quality and power quality monitoring using labVIEW has been presented in this chapter.
CHAPTER III

POWER QUALITY MONITORING USING labVIEW

3.0 INTRODUCTION:

A brief description of power quality monitoring system is represented in the successive sections without extensive elaboration.
3.1 Transducer

A transducer is a device that converts one type of energy into another. The conversion can be to/from Electricity, Electro-mechanical, Electromagnetism, Photonic, Photovoltaic or any other form of energy. While the term transducer commonly implies use as a sensor/detector, any device which converts energy can be considered a transducer.

3.2 Signal Conditioning Elements
Many real-world sensors and transducers require signal conditioning before a computer-based measurement system can effectively and accurately acquire the signal. The front-end signal conditioning system can include functions such as signal amplification, attenuation, filtering, electrical isolation, simultaneous sampling, and multiplexing. In addition, many transducers require excitation currents or voltages, bridge completion, linearization, or high amplification for proper and accurate operation. Therefore, most computer-based measurement systems include some form of signal conditioning in addition to plug-in data acquisition DAQ devices, as shown in Fig. 3.1.
[image: image5.png]



Fig. 3.1 depicts measurement of power quality
3.3 Data Acquisition Device
DAQ hardware is what usually interfaces between the signal and a PC. It could be in the form of modules that can be connected to the computer's ports (i.e. Parallel port, Serial port, USB port, etc.) or cards connected to slots (S-100 bus, AppleBus, ISA, Micro Channel architecture, PCI, PCI-E, etc.) in the Mother board.
Usually the space on the back of a PCI card is too small for all the connections needed, so an external Breakout box is required. The cable between this box and the PC can be expensive due to the many wires, and the required shielding. Data acquisition (abbreviated DAQ) is the process of sampling of real world physical conditions and conversion of the resulting samples into digital numeric values that can be manipulated by a computer. Data acquisition and data acquisition systems (abbreviated as DAS) typically involves the conversion of analog waveforms into digital values for processing. The components of data acquisition systems include:

· Sensors that convert physical parameters to electrical signals.

· Signal conditioning circuitry to convert sensor signals into a form that can be converted to digital values.

· Analog-to-digital converters, which convert conditioned sensor signals to digital values.

Data acquisition applications are controlled by software programs developed using various general purpose Programming languages such as BASIC, C (programming language), Fortran, Java (programming language), Lisp (programming language), Pascal (programming language). Graphical programming environments include Ladder logic, Visual C++, Visual Basic, MATLAB, and LabVIEW. Main component of DAQ Card is ADC (analog to digital converter) which samples the analog signals on a regular basis and converts the amplitude at each sample time to a digital value with finite resolution. These are termed discrete-time, discrete ion value functions that are defined only at times specified by the sample rate and may have values determined by the resolution of the ADC. In other words, when an analog signal is digitized, an approximation has to be made based on the signal and the specifications used for data analysis. Resolution also plays a very important role here. The additional amplitude and temporal resolution are the two important factors that are to be discussed, but they may be expensive. To overcome this, there should be a clear idea on sampling. The process of sampling is based on Nyquist Shannon’s sampling theorem.
Sampling Theorem

A fundamental rule of sampled data systems is that twice the highest frequency component in the signal .This is known as the Nyquist criterion stated as a formula it requires that fs/2 >fa , where fs is the sampling frequency and fa is the signal being sampled .Violating the Nyquist criteria is called under sampling, and results in aliasing where the signal will not be acquired in desired manner.
3.4 VIRTUAL INSTRUMENTATION

Virtual instrumentation sets a new standard in measurement by replacing bench top instruments. It uses software like NI labVIEW and hardware like PCI modules for data acquisition, instrument control and automation. VIs constructed with software are inexpensive, more accurate, maintenance free, can sense different physical quantities offering any range, compared to physical instruments. VIs works fast, handles repetitive tasks, processes data, stores results, generates reports, increases test safety and is controllable by the user. It saves time, money and increases productivity; customizability e.g. same code can be re-used for testing similar instruments. For any lab instead of buying individual instruments, VI can be employed in a computer for all measurements.
Virtual Instruments versus Traditional Instruments
Traditional instruments: Vendor defined, Function-specific; stand-alone with limited connectivity. Hardware is the key, Expensive, Closed, fixed functionality, slow turn on technology (5–10 year life Minimal economics of scale).
Virtual Instruments: User-defined, Application-oriented system with connectivity to networks, peripherals, and applications. Software is the key, low cost, reusable, Open, flexible functionality leveraging off familiar computer technology (Maximum economics of scale). Software minimizes development and maintenance costs.
3.4.1 PROGRAMMING TECHNIQUES

LabVIEW programs are called virtual instruments or VIs, because their appearance and operation imitate physical instruments, such as oscilloscopes and millimeters. LabVIEW VIs contain three components: the front panel window, the block diagram, and the icon/connector pane.

Front panel Window

The Front panel window is the user interface for the VI. Fig.3.2 shows example of a front panel window. We create the front panel window with controls and indicators, which are the interactive input and output terminals of the VI, respectively.

[image: image6.emf]
Fig.3.2 VI Front Panel
Block Diagram Window

After creating the Front Panel Window, we add code using graphical representation of functions to control the Front panel objects. Fig.3.3 shows an example of a block diagram window contains this graphical source code. Front panel objects appear as terminals on the block diagram.
[image: image7.emf]
Fig. 3.3 VI Block Diagram
Icon and Connector Pane

A VI can be used as a subVI. A subVI is a VI that is used in another VI, similar to a function in a text based programming language. To use VI as a subVI, it must have an icon and connector Pane.

[image: image8.emf]
Every VI displays an icon, shown above, in the upper right corner of the front panel and block diagram windows. An icon is a graphical representation of a VI. It can contain text, images, or a combination of both. If we use a VI as a subVI, the icon identifies the subVI on the block diagram of the VI. The default icon contains a number that indicates how many new VIs we have opened since launching LabVIEW. Create custom icons to replace the default icon by right-clicking the icon in the upper right corner of the front panel or block diagram and selecting Edit Icon from the shortcut menu or by double-clicking the icon in the upper right corner of the front panel. We also can edit icons by selecting File»VI Properties, selecting General from the Category pull-down menu, and clicking the Edit Icon button. Use the tools on the left side of the Icon Editor Dialog box to create the icon design in the editing area. The normal size image of the icon appears in the appropriate box to the right of the editing area, as shown in the following dialog box in Fig.3.4.
[image: image9.emf]
Fig. 3.4 Icon Editor

Use the options on the right side of the editing area to perform the following tasks:

• Show Terminals—Displays the terminal pattern of the connector pane.
• OK—Saves the drawing as the icon and returns to the front panel.
• Cancel—Returns to the front panel without saving any changes.
The menu bar in the Icon Editor dialog box contains more editing options such as Undo, Redo, Cut, Copy, Paste, and Clear.

[image: image10.emf] To use a VI as a subVI, we need to build a connector pane, shown at left. The connector pane is a set of terminals that corresponds to the controls and indicators of that VI, similar to the parameter list of a function call in text-based programming languages. The connector pane defines the inputs and outputs we can wire to the VI so we can use it as a subVI. Define connections by assigning a front panel control or indicator to each of the connector pane terminals. To define a connector pane, right-click the icon in the upper right corner of the front panel window and select Show Connector from the shortcut menu. The connector pane replaces the icon. Each rectangle on the connector pane represents a terminal. Use the rectangles to assign inputs and outputs. The number of terminals LabVIEW displays on the connector pane depends on the number of controls and indicators on the front panel. The following front panel has four controls and one indicator, so LabVIEW displays four input terminals and one output terminal on the connector pane. We cannot access the connector pane from the icon in the block diagram window.

[image: image11.emf]
Fig. 3.5 shows icon/connector pane on top right side (orange colour box)

Palettes
LabVIEW has graphical, floating palettes to help you create and run VIs. The three palettes include the Tools, Controls, and Functions palettes. We can place these palettes anywhere on the screen.

Tools Palette

We can create, modify, and debug VIs using the tools located on the floating Tools palette. The Tools palette is available on the front panel and the block diagram. A tool is a special operating mode of the mouse cursor. When we select a tool, the cursor icon by itself changes to the tool icon. Use the tools to operate and modify front panel and block diagram objects. Next select Window»Show Tools Palette to display the Tools palette. We can place the Tools palette anywhere on the screen. Press the <Shift> key and right-click to display a temporary version of the Tools palette at the location of the cursor.

[image: image12.emf]
Fig 3.6 Tools palette
[image: image13.emf]Use the Operating tool to change the values of a control or select the text within a control.

[image: image14.emf]Use the Positioning tool to select, move, or resize objects

[image: image15.emf]Use the Wiring tool to wire objects together on the block diagram.
Control and Function Palettes

The Controls and Functions contain sub-palettes of objects to create a VI. When click on sub-palette icon, the entire palette changes to the selected sub-palette. To use an object on the palettes, click the object and place it on the front panel or block diagram.

Controls Palette

Use the Controls palette to place controls and indicators on the front panel. The Controls palette is available only on the front panel. From there select Window»Show Controls Palette or right-click on the front panel workspace in order to display the Controls palette. We also can display the Controls palette by right-clicking an open area on the front panel. Tack down the Controls palette by clicking the pushpin on the top left corner of the palette.

[image: image16.emf]
Fig 3.7 Control Palette
Functions Palette

Use the Functions palette to build the block diagram. The Functions palette is available only on the block diagram. Select Window»Show Functions Palette or right-click the block diagram workspace to display the Functions palette. You also can display the Functions palette by right-clicking an open area on the block diagram. Tack down the Functions palette by clicking the pushpin on the top left corner of the palette.
[image: image17.emf]
Fig 3.8 Function palette

3.4.2 Starting a VI

When we launch LabVIEW, the following dialog box appears.
[image: image18.jpg]



Fig 3.9 start window that appears when labVIEW is launched
[image: image19.jpg]



Fig 3.10 Dialog box for Getting Started of labVIEW

The LabVIEW dialog box includes the following components:

• Click the New VI button to create a new VI.

• Click the Open VI button to open an existing VI.

• Click the DAQ Solutions button to launch the DAQ Solution Wizard, which helps we find solutions for common DAQ applications.

• Click the Search Examples button to open a help file that lists and links to all available

LabVIEW example VIs
• Click the LabVIEW Tutorial button to open the interactive LabVIEW Tutorial. Use this tutorial to learn basic LabVIEW concepts.

3.4.3 Troubleshooting and Debugging VIs

Use the Context Help window and the LabVIEW Help to help you build and edit VIs.
Context Help Window

To display the Context Help window, select Help » Show Context Help or press the <Ctrl-H>key. When we move the cursor over front panel and block diagram objects, the Context Help window displays the icon for sub VIs, functions, constants, controls and indicators, with wires attached to each terminal. When we move the cursor over dialog box options, the Context Help window displays descriptions of those options. In the window, required connections are bold, recommended connections are plain text, and optional connections are dimmed or do not appear. The following is an example Context Help window.
[image: image20.emf]
Fig. 3.11 shows Context Help

[image: image21.emf]Click the More Help button to display the corresponding topic in the LabVIEW Help, which describes the object in detail.

3. 5 Advantages of VI:

Long before people used typewriters, which were then replaced by the word processors that offered new levels of productivity and flexibility. Much as the same way, VIs will replace the physical instruments.

[image: image22.jpg]



The picture on the top is that of a real instrument and the one on the bottom is that of a virtual one. Today's computer's graphic capabilities even make VIs look like real instruments. Virtual instruments are better connected to PC technologies widely used in industries. With VI, users can move applications seamlessly between several bus architectures, such as PC Card, plug-in DA hardware, and VXI. This portability offers the flexibility to take advantage of improved bus standards as they arise.

Customizability VIs are fully customizable. Range, accuracy, amount of information provided by them can be selected by users. Data can be saved in computer and send it over the internet. They can be made to sense any physical quantity offering any range with the use of corresponding sensors. A VI can be made to control any other instruments including another VI.
Increases productivity VIs are less expensive and maintenance free. They work very fast, handle repetitive tasks, process data, store results and also generate reports. Reuse of code is also possible. Thus the same code can be used for testing similar instruments which saves time and money. Doing things in less time would definitely mean being able to do more. With less time, money and human labour for the same product, the productivity increases rapidly.

Lowers cost for customers Physical instruments are not suited for extreme weathers, but VIs can work in any hazardous environments. When a new product is tested using expensive test equipments, it naturally raises the overhead cost. Employing VI there reduces the testing cost. They also increase the test safety. They do not get damaged and thus no need of replacements. This lessens the price of the final product for customers.

User friendliness The software used for VI is user friendly. In LabVIEW, new users can step through the dialogue boxes and quickly build a fully functioning DA application. LabVIEW will help define signal types, connections, and transducer equations before building the system. Thus, the learning curve is shortened significantly. More experienced developers can use the DAQ Wizards to prototype a system.
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Most VI system contains a microprocessor, a data-acquisition unit or system, an I/O port, a display or a way of reporting the results and an analysis engine. Since most of the hardware is the same, only the front-end of the device needs to be changed to suit the equipment's purpose. With a personal computer, software could do the analysis after acquiring the needed data. Thus, the software could be written as such to specifically answer what is called for by the analysis. The hardware could be changed according to the design of the experiment, whether it will receive data from an apparatus or control it. Instead of using separate hardware front-ends, software could be written for measuring different quantities. Thus with sensors and appropriate software, any physical quantity can be acquired and measured in VI.

Some other applications of VI are data analysis, systems control, process automation, testing and calibration of instruments, telecommunications, semiconductor manufacturing, automotive testing, robotics, automation, embedded systems, etc.
3.6 CONCLUSION

The future of virtual instrumentation is promising. As such companies as Intel and Microsoft continue to usher in new technologies for advanced productivity and connectivity; virtual instrumentation’s benefits will increase. Improvements in PC technology and VI hardware and software will make new applications possible. Companies like National Instruments are promoting VI to make it reach everyone. Quite sooner the traditional instrumentation will be completely moved inside the computer.
CHAPTER IV

ANALYZER USING LabVIEW

4.0 INTRODUCTION

The ever growing proliferation of power switching devices for source conditioning and motion control in single-phase and three-phase modern industrial applications has increased the eventuality of unbalanced currents, unacceptable harmonic levels, and poor power factor in three-phase distribution systems. The harmful and costly effects of harmonics have been extensively discussed [17] and spurred stringent requirements by international institutions regarding the allowed levels of harmonics at the point of connection to the power supply [18]–[20]. The unbalanced loading of the three-phase supply has no less detrimental effects, such as the underutilization of the power supply equipment and the overloading of neutral conductors with the fundamental frequency in addition to harmonic currents. Finally, as is well known, a phase displacement between the corresponding voltages and currents indicates both a low utilization of the generation and distribution equipment and increased line losses for the same power consumption level.

In this thesis, a power quality factor (PQF) that integrally assesses the quality of the power transfer to a given load connected to a three-phase supply from all the aspects mentioned above is suggested. It is remarked that a low power transfer quality could be caused either by the power supply (through unbalanced supply voltages and/or voltage harmonics), by the load (nonlinear and/or unbalanced load), or by both [21]. The newly suggested PQF has the advantage of evaluating the power quality at any selected point in a distribution network by means of a single indicator rather than separately comparing a multitude of factors with their recommended values, which thus considerably simplifies the rate structures. The measuring device offers the additional feature of distinctly measuring the different aspects affecting the power quality, thus identifying any specific power quality aspect that needs attention.

The main aspects of power transfer quality at a selected point in a three-phase supply are formulated in Section 4.2. These are used in Section 4.3.1 to define the PQF and accordingly measure it. A steady state is assumed. Examples that illustrate the use and relevance of the PQF are presented in Section 4.4.1. The simplicity offered by this factor allows the development of efficient rate structures and eventual enforcing policies that aim at the enhancement of the reliability and power quality of the mains.

4.1 Quality of the Electrical Signal
Power systems operate with a constant line voltage, supplying power to a wide variety of load equipment. Power levels range from a few watts to megawatts, and the voltages at which the energy is generated, transported, and distributed range from hundreds of volts to hundreds of kilovolts. Transmission and primary distribution of this power are made at high voltages, tens to hundreds of kilovolts, in order to provide efficient and economic transportation of the energy over long distances. Final utilization is generally in the range of 120 V (or 220 V) (typical residential) to less than one thousand (industrial), and a few thousands for large loads. At all these voltage and power levels, no matter how high, the equipment is dependent upon maintenance of a normal operating voltage because it has only limited capability of withstanding voltages exceeding the normal level. At lower than normal levels, the equipment performance is generally unsatisfactory, or there is a risk of equipment damage. These two disturbances, excessive voltage and insufficient voltage, are described with different names depending on their duration. There are also types of disturbances, as described in section 1.4 involving waveform distortion and other deviations from the expected sine wave. Emerging concerns over these issues has resulted in attention being focused on the quality of the power necessary for successful operation of diverse loads, on practical limits to the capability of delivering power of high quality to diverse customers, and on the economics of the producer-user partnership. The term “power quality” is now widely used, but objective criteria for measuring the power quality - a prerequisite for quantifying this quality - needs better definition. A high level of power quality is understood as a low level of disturbances, agreement on acceptable levels of disturbances is needed.
4.2 Quantitative Formulations of Power-quality Aspects
The term “power quality” is defined as “set of parameters defining the properties of power quality as delivered to the user in normal operating conditions in terms of continuity of supply and characteristics of voltage (frequency, magnitude, waveform, symmetry)” in IEC Standard [24]. However, in IEEE Standard [22] “power quality” is defined as “The concept of powering and grounding electronic equipment in a manner that is suitable to the operation of that equipment and compatible with the premise wiring system and other connected equipment”. As shown in these definitions, “power quality” includes considerations of all aspects of power supply. In this chapter, we focus on the effect of the quality of power on sensitive loads. Under steady-state conditions, three power-system parameters - frequency, waveform distortion, and symmetry - can serve as frames of reference to classify the disturbances according to their impact on the quality of the available power. The phase displacement between voltage and current has been added as another important quality aspect.
4.2.1 Total Current and Voltage Harmonic Distortion
Harmonic distortion is the corruption of the fundamental sine wave at frequencies that are multiples of the fundamental. Power signal waveforms are not clean 50 Hz sine waves. In practice the actual waveforms are distorted one due to presence of harmonics. Harmonics occur at an integral multiple of the base frequency. In 3-phase system odd harmonics excluding tripled frequency are prevalent. Hence 5th, 7th, 11th and even higher order harmonics can be found in the supply waveform. Waveform harmonics are usually caused by equipment which draws non-linear currents. Modern electrical equipment such as computerized equipment and telecommunication equipment often use switching power supplies to “step up” or “step down” the voltage. This introduces a non-sinusoidal load which pulls current in short pulses during every cycle. Other non-linear devices such as digital/electronic components and arching devices like fluorescent lamps can cause abnormal waveforms and serious decreases in power quality. Other loads contributing to this problem are variable speed motor drives, lighting ballasts and large legacy UPS systems. Symptoms of harmonic problems include overheated transformers, neutral conductors, and other electrical distribution equipment, as well as the tripping of circuit breakers and loss of synchronization on timing circuits that are dependent upon a clean sine wave trigger at the zero crossover point. Harmonic distortion has been a significant problem with IT equipment in the past, due to the nature of switch-mode power supplies (SMPS). Methods used to mitigate this problem have included over-sizing the neutral conductors, installing K-rated transformers, and harmonic filters [18, 19].Harmonics work together in distorting the fundamental waveform. Fig.4.1 shows a sinusoidal signal with harmonic content.

[image: image24.emf]
Fig. 4.1: Sinusoidal signal with Harmonic content

The representation of the harmonic current with respect to the fundamental waveform is called total harmonic distortion (THD). There is a THD for both voltage and current. The total harmonic distortion of the voltage and current VTHD and ITHD, respectively, for single-phase (or polyphase balanced) networks have been conventionally defined in the literature as where V And I denotes rms values and 1 and h denote the fundamental and the harmonic order, respectively.
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To account for the fact that higher-order harmonic currents cause greater losses than lower-order harmonics of the same amplitude, harmonic-adjusted total voltage and current harmonic distortions are, respectively defined as:
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Where, Ch and Dh are appropriate weighting factors, greater than one, that monotonically increase with the harmonic order h. Various mathematical expressions, by no means exhaustive, for these weighting factors as a function of the harmonic order h are suggested in [20].An extension of the above concepts to unbalanced polyphase networks has been suggested in [21]. To this end a single “equivalent” harmonic rms voltage VeH and harmonic rms current Ieh for the three-phase system a, b, c are defined as:
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It is proposed to generalize equations (4.5) and (4.6) and separately weigh individual harmonics similar to (4.3) and (4.4), which yield the adjusted harmonic equivalent values 
[image: image28.png]2 2 2 2 2 2 2

2 Van+ Vion+Ven - 2 Ngn+ | !
AL AL [ ZD,. an® “bht h
i) 3

eq(a7) ..€q(4.8)




The first introduced quality aspects QA1 and QA2 are identified with the total harmonic distortions VTHD and ITHD for a three-phase unbalanced system and are defined as:[image: image29.png]QA; = VTHD = QA= ITHD =
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Where Ve1 and Ie1 denote the fundamental equivalent phase voltage and current defined, similarly to Equation (4.5) & (4.6), from the fundamental components of the generally unbalanced three-phase voltages and currents as:
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Definition of Equations 4.(5-8),4.11 and 4.12  satisfy the particular requirement that the total losses in the equivalent balanced three-phase system be equal to those in the actual system considered. The underlying assumptions are that a) the line and equipment losses for a certain frequency are proportional to either the square of the voltage or the square of the current and b) the line and equipment parameters are symmetrical.
Linear loads have very low values of THD because they have little or no harmonic current. Non-linear loads have large values of THD, and cause considerable distortion to the normal sine wave. Within the IEEE [18], the standard established limits on harmonic currents and voltages at the point of common coupling (PCC) or at the point of metering are 5% THD at the distribution system voltage level. As far as the historical development of the compatibility levels within the IEC [19] standards framework is concerned, the newly published standard allows THD of the voltage to be 11 % for a short period of time, and sets the long-term limit to 8 %. This development shows that the trend is to allow for more distortion in the distribution networks in the future.
Implementation of QA1 and QA2 in LabVIEW:
To implement the above quality aspects i.e. QA1 (VTHD) and QA2 (ITHD) using labVIEW first we need to simulate voltage and current waveforms hence voltage and current waveforms are simulated keeping in mind the actual distorted waveform due to presence of harmonics which occur at integral multiple of the base frequency. In this project distorted waveform has been simulated by superimposing 5th harmonic on fundamental frequency waveform.

To simulate a signal in labVIEW, first we need to create new VI (File >> New VI) and then it will show Front Panel from where we should go to block diagram by pressing <ctr-E> or from toolbar (windows>>show Block diagram) from where we should right click anywhere on the block diagram then it will show functions palette i.e. (functions>>Express>>Input>>Simulate Signal) then you will get simulate signal Express VI which is shown below from where we need to configure signal according to our requirement.
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Here in this case a balanced three phase non-sinusoidal voltage source was implemented defined by Vphase=220V (rms) and by adding a fifth-order harmonic having an amplitude of 5 % of the fundamental which is as shown below block diagram.
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Fig 4.2 Block Diagram /G programming of distorted voltage wave form
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Fig 4.3 Front Panel Presenting Distorted voltage waveform

Here in the Front Panel signal we can see simulation of three phase voltage forms. In the same manner distorted current wave form is simulated by assuming a balanced resistive load defined by Ra=Rb=Rc =10Ω is connected to above source.
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Fig 4.4 Block diagram of current wave form
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Fig 4.5 Front Panel presenting current waveform
The above VIs are used as subVI as shown below for calculating QA1 and QA2. A subVI is a VI that is used in another VI similar to a function in text programming language . Advantage of using a VI as subVI is to simplify the programming complexity. The programmer can easily manage and test these subtasks to reduce dependencies tha might cause unexpected behaviour this shows the importance of modularity property in labVIEW.
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QA1 and QA2 are calculated by programming the above discussed formulas in block diagram which is as shown below.
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Fig 4.6 Block diagram of voltage total harmonic distortion analyzer
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Fig 4.7 Front Panel Presenting Voltage Total Harmonic Distortion Analyzer

Similarly,
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Fig 4.8 Block diagram of current total harmonic distortion analyzer
[image: image41.png]



Fig 4.9 Front Panel Presenting Current Harmonic Distortion Analyzer

4.2.2 Degree of Unbalance

As is well known, unbalanced voltages and currents in polyphase networks affect the quality of power transfer in many aspects, such as increased line losses for the same power-transfer level, extra rotating losses in drives and overloading of neutral conductors in four-wire distribution systems.

Applying the theory of symmetrical components [22], an unbalanced three-phase sinusoidal voltage system [Va, Vb, Vc] can be decomposed into a positive-sequence three-phase balanced system V+, a negative-sequence system V–, and a zero sequence system V0 according to
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Where V denotes the phasor of V and the factor a= exp (j2π/3). The symmetrical components of the currents I+, I– and I0 at the fundamental frequency are derived similarly. From Equations 4.7–4.9, after some manipulations, the equivalent voltage can be expressed as
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Identical considerations apply to the three-phase currents where V is exchanged by I. Pertinent quality aspects QA4 and QA5 are the voltage and current unbalance factors VUNB and IUNB, respectively, defined as
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The voltages and currents in the definition of Equation 12.10 denote absolute values of the corresponding phasors as defined in Equations 12.7 and 12.8. For balanced three-phase voltages and currents it can readily be shown from Equation 12.8 that V–, V0, I– and I0are equal to zero, Ve1= V+, Ie1= I+, and hence QA3 = QA4= 0.
Implementation of QA3 and QA4 using LabVIEW:

To implement the above discussed quality aspects QA3 and QA4 i.e. Voltage Unbalance and Current Unbalance using labVIEW first we need to get phasor of the waveform i.e. magnitude as well as angle which is possible by using inbuilt VI defined as:
Extract Single Tone Information VI
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time signal in is the time-domain waveform.

detected amplitude is the amplitude of the detected single tone in Vp.
detected phase is the phase of the detected single tone in degrees.

It is easier to perform computations using complex numbers rather than polar notation hence to convert polar in to complex there is a function called polar to complex in labVIEW which is as shown below:

Polar to Complex Function
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Where, r can be a scalar number, an array or cluster of numbers, array of clusters of numbers, and so on.

theta can be a scalar number, an array or cluster of numbers, array of clusters of numbers, and so on. theta is in radians.
r * e^(i*theta) is of the same data type structure as r and theta, with complex representation instead of scalar
As the input to the Polar to complex function theta should be in radians hence the output of extra single tone information VI phase (deg) should be converted in the form of radians by the formula:
Θ (rad) = π/180 * Θ (deg) which is then passed to the above function and all computations are performed as per definitions and block diagram is programmed as shown
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Fig 4.10 Block diagram determining voltage unbalance factor
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Fig 4.11 Front Panel Presenting Voltage Unbalance Factor
In the same manner Current Unbalance Factor is also programmed as shown below
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Fig 4.12 Block Diagram representing current unbalance factor
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Fig 4.13 Front Panel Presenting Current Unbalance Factor

4.2.3 Phase Displacements Between Corresponding Fundamental Voltage and Currents

In a power-transfer context, a phase displacement between the fundamental frequency voltage and current in a source or load indicates a less than full utilisation of the generation and distribution equipment as well as increased line losses for the same level of power transfer. This has been traditionally expressed through the concept of a power factor K defined in single-phase situations as the ratio between the average active power P and the apparent power S, the latter being the product of the rms values of the voltage and current. In a non-sinusoidal situation, however, the concept of power factor has been proved to be misleading [11, 37]. Moreover, a universally accepted definition of the power factor in polyphase situations has been lacking and hotly debated for almost a century [17]. This stems from the different definitions and interpretations of the apparent power in these situations. It should be noted in this context that only the instantaneous power, i.e. the product of the instantaneous values of the voltage and current, has the physical meaning of power. The conventional active power P derives its physical relevance from being the time average of the instantaneous power. In contrast, the apparent power S has no physical meaning since it does not consider the corresponding values of the voltage and current at each instant. Only in the special case when the instantaneous voltage bears a constant ratio to the instantaneous current does the apparent power equal to P and hence acquires the physical meaning of the latter [23]. All the inadequacies and ambiguities above can be circumvented when the physical entity directly responsible for a poor utilization of the power capacity at the mains fundamental frequency is considered. This entity is the phase difference between the fundamental frequency voltage and current at the terminals of the source or load. To reflect this aspect of power quality, a new factor, designated the orthogonal current factor (OCF), is suggested as follows:
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Where, I1a, I1b and I1c denote the rms values of the phase currents at the fundamental frequency and ϕ1a, ϕ1b and ϕ1c denote the phase differences between the fundamental frequency components of the corresponding phase voltages and currents.

The rationale behind Equation 4.14 is that the orthogonal current component Isinϕ, of a phase current w.r.t the corresponding phase voltage, is directly related to the effort required to ideally reduce the phase ϕ to zero. For example, in a single phase situation, the capacitance required to connect in parallel to an inductive load to bring ϕ to zero is given by:
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In particular instances lagging and leading orthogonal components in different phases may partially or totally cancel each other in Equation 4.14. This means however that the polyphase system is strongly unbalanced and the unbalance quality aspects in Equation 4.14 would prominently reflect it.
Implementation of QA5 using LabVIEW

To implement the above discussed quality aspect in LabVIEW first we need to find the phase displacement between voltage and current signal which is possible in LabVIEW using extract Single Tone Information VI where it detects the phase of the signal (in deg) . Using this VI phase of both voltage and current signal are detected and then they are subtracted which is then passed to the sine function (according to the given definition 4.16) as the input to the sine function should be in radians the resultant phase is converted to rad and then the procedure is followed as per definition 4.16 and the final resultant can be negative value hence the result is absolute of final value and in this manner the above quality aspect is implemented in LabVIEW which is observed as shown in Block Diagram.
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Fig 4.14 Block Diagram of Orthogonal Current Factor
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Fig 4.15 Front Panel Presenting Orthogonal Current Factor
4.3 Power-quality Factor

Power quality, like quality in other goods and services, is difficult to quantify. There is no single accepted definition of “quality power”. There are standards for voltage and other technical criteria that may be measured, but the ultimate measure of power quality is determined by the performance and productivity of end-user equipment. If the electric power is inadequate for those needs, then the “quality” is lacking. While the common term for describing the subject of this chapter is power quality, it is actually the quality of the voltage that is being addressed in most cases. Technically, in engineering terms, power is the rate of delivery or energy and is proportional to the product of the voltage and current. It would be difficult to define the quality of this quantity in any meaningful manner. The power supply system can only control the quality of the voltage; it has no control over the currents that particular loads might draw. Therefore, the standards in the power quality area are devoted to maintaining the voltage within certain limits. Alternating-current power systems are designed to operate at a sinusoidal voltage of a given frequency (typically 50 or 60 Hz) and magnitude. Any significant deviation in the magnitude, frequency, or purity of waveform is a potential power-quality problem. Of course, there is always a close relationship between voltage and current in any practical power system. Although the generators may provide a near-perfect sine-wave voltage, the current passing through the impedance of the system can cause a variety of disturbances to the voltage. For example, the current resulting from short-circuit causes the voltage to sag, or disappear completely, as the case may be. Distorted currents from harmonic-producing loads also distort the voltage as they pass through the system impedance. Thus a distorted voltage is presented to other end-users. Therefore, while it is the voltage with which we are ultimately concerned, in some situations we must address phenomena in the current to understand the bases of many power-quality problems.

4.3.1 Definition of the Power-quality Factor
A single measurable indicator, designated the power quality factor (PQF), is suggested to integrally reflect the different power-quality aspects formulated in the last section. This is expressed as:
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Where, wi are judiciously selected weighting factors that sum up to one and QAi are the different quality aspects formulated in Section 4.3. A balanced loaded network, with sinusoidal currents and voltages and zero phase displacements yield an ideal PQF of unity. Conversely, a low value of PQF would indicate a low degree of utilization of the power capacity of the source and/or a high level of harmonics and/or a high degree of unbalance between the phases with the contribution of each aspect well defined and measurable as illustrated later. The weighting factors wi together with the recommended value of PQF are optimally selected so as to reflect the economic and technical importance of a high power quality in each of its aspects. Any particular recommendation in practice should be supported by an appropriate economic study. The considerations in such a study are, on the one hand, the relative cost and availability of balancing circuits, reactive power compensation and harmonic passive or active filters for harmonic mitigation and, on the other hand, the economic gains resulting from a high-quality power transfer, such as a high degree of utilisation of the source capacity, prolonged life of system components and minimisation of system outages due to resonance phenomena caused by harmonics. These considerations are much the same as those required to specify acceptable limits to the voltage and current distortions or the minimum tolerated power factor, deviations from which are usually penalised in the rate structure.
Notable features of Equation are
1) It gives a quick assessment of the power transfer quality at the selected point of the supply.

2) It does not make use of controversial or misleading quantities such as apparent power and power factor in non-sinusoidal situations.

3) It can be expanded to include additional power-quality aspects (QAs) such as voltage sags and swells adequately defined in terms of their frequency and/or amplitudes.

4) The weighting factors are selected to reflect technical priorities and objectives with due consideration to economic and practical issues. These factors may (and should) be different in different situations and environments.
For implementing Power Quality Analyzer using definition which is given in section 4.3.1 (eq. 4.18) in labVIEW  the different Quality Aspects which were implemented as shown in section 4.2 are taken as subVI as shown below for simplification purpose and for ease of understanding quickly.
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The concept of subVI is that the whole code which was programmed for calculating a particular Quality Aspect will be embedded in the icon which is as shown above on double clicking this icon when displaced in Block diagram we will retrieve whole code. In this way it simplifies programming which is very useful property for doing my project. Here in this case a balanced inductive load is connected to an unbalanced three phase non-sinusoidal source where current lags voltage by 30 deg which is as shown in the below figure and hence yields a power quality factor of 0.817.
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Fig 4.16 Block Diagram of POWER QUALITY ANALYZER
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Fig. 4.17 Front Panel Presenting Power Quality Analyzer
4.4 Measurement of PQF

A conceptual block diagram of a device that measures the PQF as defined in Equations 4.16 and 4.17 at a chosen location in a power system is shown in Figure 4.18. The device offers the additional feature of distinctly measuring the different quality aspects formulated in Section 4.3 so that, if necessary, the power-transfer aspect that needs correction is identified. The direct measurement of PQF offers the convenience of assessing the power-transfer quality by means of a single indicator rather than requiring separate measurements of various entities and individually comparing them with their respective recommended values.
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Fig. 4.18 Conceptual block diagram for the measurement of the power quality factor and assessing of the different quality aspects in a three-phase supply
4.5 CONCLUSION:

Power Quality Analyzer using Virtual Instrumentation concept has been successfully developed in LabVIEW Software considering three quality aspects Total Harmonic Distortion Factor, Unbalance, Phase displacement between voltage and current and weighting factors are chosen according to economic objective and load environment.
CHAPTER V
MONITORING USING ADVANTECH DAQ CARD
5.0 I NTRODUCTION:

This chapter discusses about second objective i.e., for monitoring power line disturbances which is configured as virtual instrument, which automatically indicates the type of disturbance that has occurred in system. The type of disturbances include: impulse, sag, swell, interruption, harmonics and frequency variation. This virtual instrument permits the measurement of parameters such as amplitude, rms value, detected fundamental frequency, no. of impulses that have occurred and its location and amplitude, harmonic content in the supplied signal. Here in this case input signal is acquired from function generator (in real time input signal will be acquired from corresponding transducer) which is then given to PCI-1711 Multi function ADVANTECH DAQ card through PCLD-8710 Screw terminal Board (used when there is no sufficient space available for connections in multifunction card) and then the acquired signal is depicted on the front panel of virtual instrument in PC.
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Applications that are performed using LabVIEW software which was introduced by National Instrument are compatible for National Instruments hardware .Therefore , the driver will not recognize ADVANTECH DAQ card hence Advantech 32-bit LabVIEW drivers enable you to use Advantech plug-in I/O cards with LabVIEW software. Advantech offers a rich set of DLL drivers, third party driver support and application software to help fully exploit the functions of PCI-1711 Multi function DAQ Card:

· DLL driver (on the companion CD-ROM)

· LabVIEW driver forms an interface between Advantech DA&C device DLL drivers, which contain all the relevant functions to control Advantech plug-in I/O cards and the LabVIEW software. LabVIEW driver forms a VI (virtual instrument) in the LabVIEW package, which enables other applications to be used in conjunction with Advantech plug-in I/O cards.

· Advantech ActiveDAQ

· Advantech GeniDAQ
5.1 EXPERIMENTAL SETUP:
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5.1.1 FUNCTION GENERATOR:

A Function Generator is an electronic test equipment or software used to generate electric waveforms. These waveforms can be either waveform repetitive, or single-shot in which case some kind of triggering source is required. It is used to test the response of circuits to common input signals.
5.1.2 PCLD 8710 SCREW TERMINAL BOARD:
PCLD-8710 is designed to match multifunction cards with 68-pin SCSI-II connectors, such as PCI-1710/1710L/1710HG/1710HGL/1711/1711L/1716/1716L cards. This screw-terminal board also includes cold junction sensing circuitry that allows direct measurements from thermocouple transducers. Together with software compensation and linearization, every thermocouple type can be accommodated. Due to its special PCB layout, we can install passive components to construct your own signal-conditioning circuits. So you can easily construct a low-pass filter, attenuator or current shunt converter by adding resistors and capacitors onto the board circuit pads.

5.1.3 WIRING CABLE PCL-10168 :

PCL-10168: shielded cable which is specially designed for PCI-1711 card to provide high resistance to noise. To achieve better signal quality, the signal wires are twisted in such a way as to form a “twisted – pair cable “, reducing cross - talk and noise from other signal sources. Furthermore, its analog and digital lines are separately sheathed and shielded to neutralize EMI/EMC problems. Hence the communication between PCI-1711 Card and PCLD-8710 is through wiring cable PCL-10168 which is as shown in below figure but practically PCI-1711 Multi Function Card will be inserted in PC therefore it cannot be viewed .
[image: image66.jpg]Incustrial Wiring Termi
[DIN-rail Mounting (cable ot includec)





5.1.4 PCI-1711 MULTI FUNCTION CARD

PCI-1711 powerful, but low-cost multifunction cards for the PCI bus. PCI-1711 comes with 2 analog output channels. Thus, PCI-1711L represents a cost saver for those that do not need analog output.
Features

16-ch single-ended analog input

12-bit A/D converter, with up to 100 kHz sampling rate

Programmable gain

Automatic channel/gain scanning

Onboard FIFO memory (1,024 samples)

Two 12-bit analog output channels (PCI-1711 only)

16-ch digital input and 16-ch digital output

Onboard programmable counter
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Fig PCI-1711 Multi Function Card
5.1.5 PROGRAMMING IN LabVIEW SOFTWARE:

To implement monitoring of power quality line disturbances using Virtual Instrumentation first signal should be acquired which is possible with the help of Acquire Analog Input Wave Form VI ((Getting Started LabVIEW 8.2 >>Blank VI>> press <ctr-E> shift key) and then block diagram will be viewed from where right click anywhere on the empty space then Functions palette will appear (functions palette >> User Libraries >> Advantech DAQ >> Analog Input >>ADV AI Acquire Wave Form .vi)) which is as shown below:
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Inputs to the above icon are: Device name-device number assigned to the DAQ device during configuration here it is 0 , channel no.- from which channel analog input has to be measured here it is 2, no. of samples – default value is 1000, Sample rate- default value is 1000.

Output: Acquired waveform.

After acquiring signal, to analyze the acquired signal, the output of ADV AI Acuire Waveform is wired to Harmonic Distortion Analyzer (right click anywhere on empty space of block diagram, functions palette will appear Functions Palette >> signal processing >> Waveform measure >> Harmonic Distortion Analyzer) which is as shown below where it detects fundamental frequency, Total Harmonic Distortion of input signal.
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Input – Acquired Waveform

Output-detected fundamental frequency of the signal, Total Harmonic Distortion content of the signal. To detect cycle RMS of the acquired signal, output of ADV AI Acuire Waveform is wired to Cycle Average and RMS icon (Functions Palette >> signal processing >> Waveform measure >> Cycle average and rms .vi) which is as shown below , where it computes RMS value.
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Input – Acquired Waveform
Output – RMS Value of the cycle

To monitor power quality line disturbances such as Voltage sag, Voltage Swell, interruption and Frequency change as per given definitions in section 1.1 there is an option available in LabVIEW i.e., In Range and Coerce icon (shown in below figure) (Functions Palette >> comparison >> In Range and Coerce) which is as shown below where it determines whether if the input falls within a range specified by the upper limit and lower limit inputs accordingly it indicates a Boolean value true (red) or false (green).
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Input – upper limit, lower limit, input.

Output – Boolean Value (True or False)

With the help of above icon we can identify the disturbance that has occurred and accordingly it indicates whether it is voltage sag, voltage swell, interruption and frequency change.

To know the information about impulses there is an icon called Peak Detector (Functions Palette >> Signal Processing >>Signal Operation >> Peak Detector) which is as shown below, where it detects the no. of impulses found, its location and amplitude.
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Inputs: Acquired Waveform, threshold, Peak/Valley.

Outputs: #found, location, amplitude

From above discussion Block Diagram was constructed for monitoring power quality as shown below as to acquire data continuously while loop is used, it stops acquiring data when stop button on Front Panel is pressed.
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Fig. Block Diagram of POWER QUALITY MONITORING VI
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Fig. Front Panel Presenting Power Quality Monitoring VI
5.1.6 OSCILLOSCOPE:
An oscilloscope (abbreviated sometimes as scope or O-scope) is a type of electronic test equipment allows signal Voltage to be viewed, usually as a two-dimensional graph of one or more electrical potential difference (vertical(Y) axis) plotted as a function of time or of some other voltage (horizontal(x) axis). Although an oscilloscope displays voltage on its vertical axis, any other quantity that can be converted to a voltage can be displayed as well. In most instances, oscilloscopes show events that repeat with either no change or change slowly. The oscilloscope is one of the most versatile and widely-used electronic instruments. Oscilloscopes are commonly used when it is desired to observe the exact wave shape of an electrical signal. In addition to the amplitude of the signal, an oscilloscope can show distortion and measure frequency, time between two events (such as pulse width or pulse rise time), and relative timing of two related signals. To verify whether acquired signal is matching with the input signal oscilloscope is used.

5.2 CONCLUSION:
Monitoring of power quality disturbances such as voltage sag, voltage swell, Frequency change, Interruption, impulse, harmonic distortion content has been successfully detected with ADVANTECH DAQ Card using LabVIEW software.
CHAPTER VI
RESULTS AND DISCUSSIONS
6.1 Illustrative Use of Power-quality Factor

The use and relevance of the power-quality factor suggested in the section 4.3 are illustrated in the following through numerical examples of various three-phase source/load configurations. Four cases are analyzed for the PQF measurement:

a) An unbalanced resistive load supplied by a balanced three-phase sinusoidal voltage source here in this case an unbalanced resistive load defined by Ra= 10 Ω; Rb= 20 Ω; Rc= 10 Ω, is connected to a balanced three-phase sinusoidal source defined by Vphase1= 220 V. The weighting factors Ch and Dh in Equation 12.5 are given by 1 and 1, respectively. The calculated values of the quality aspects QA1 to QA6 as defined are 0, 0, 0, 0, 0.272, and 0, respectively. For equal weighting factors wi= 0.2 for all i in Equation 4.18, this yields a power quality factor PQF of 0.955.

b) A balanced resistive load supplied by an unbalanced three-phase sinusoidal voltage source here in this case  a balanced resistive load defined by Ra= Rb= Rc=10 Ω, is connected to an unbalanced three-phase sinusoidal source defined by Va= 220 V; Vb= 237.60 V and Vc= 220 V. The calculated values of the quality aspects QA1 to QA6 are 0, 0, 0, 0.0367, 0.0367, and 0, respectively. This yields a power-quality factor PQF of 0.988;

c) A balanced resistive load supplied by an unbalanced three-phase non-sinusoidal voltage source here in this case  the balanced resistive load defined as Ra=Rb=Rc=10Ω  is connected to an unbalanced non-sinusoidal source. The non-sinusoidal voltage source was implemented by adding to the above-defined three-phase voltages a fifth-order harmonic having amplitude of 5% of the fundamental. The calculated values of the quality aspects QA1 to QA6 are 0, 0.049, 0.049, 0.037, 0.037, and 0, respectively, which yields a PQF of 0.971;

d) A balanced inductive load defined as Ra=Rb=Rc=10Ω & La=Lb=Lc=10mH is connected to the voltage source of above case which yields a PQF=.89.

a) An unbalanced resistive load supplied by a balanced three-phase sinusoidal voltage source [image: image75.png]e aay =
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Fig 6.1 Front Panel presenting PQF for an unbalanced load and balanced source
OBSERVATIONS:
· Both voltage and current waveforms are pure sinusoidal as there is no fifth harmonic content added to the fundamental hence there is no harmonic distortion therefore QA1 & QA2 =0.

· There is no voltage unbalance as we can see from graph Va=Vb=Vc=220V (rms) but there is current unbalance as the load connected to source is unbalanced resistive load i.e., Ra=10Ω, Rb=20Ω, Rc=10Ω hence QA3=0 & QA4=0.204.
· There is no phase displacement between voltage and current waveforms as the load is resistive load which is linear in nature therefore QA5=0.

· From above results we can calculate PQF from definition 4.18 taking weighting factors as 0.2 hence PQF=0.959 which has been verified with hand calculations.
b) A balanced resistive load supplied by an unbalanced three-phase sinusoidal voltage source [image: image76.png]



Fig 6.2 Front Panel presenting PQF for an balanced load and unbalanced source
OBSERVATIONS:

· Both voltage and current waveforms are pure sinusoidal as there is no fifth harmonic content added to the fundamental hence there is no harmonic distortion therefore QA1 & QA2 =0.

· There is voltage unbalance as well as current unbalance as we can see from graph Va=220v Vb=237.6v Vc=220V(rms) & Ia=22A ,Ib=11.88A, Ic=22A (rms) even though load connected to source is balanced resistive load i.e., Ra=10Ω ,Rb=10Ω,Rc=10Ω because source is unbalanced hence QA3=0.0259 & QA4=0.0204.
· There is no phase displacement between voltage and current waveforms as the load is resistive load which is linear in nature therefore QA5=0.
· From above results we can calculate PQF from definition taking weighting factors as 0.2 hence PQF=0.989 which has been verified with hand calculations.
c) A balanced resistive load supplied by an unbalanced three-phase non-sinusoidal voltage source;
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Fig 6.3 Front Panel presenting PQF for an unbalanced load and unbalanced non-sinusoidal source.
OBSERVATIONS:

· Both voltage and current waveforms are non-sinusoidal as there is 5% of fundamental fifth harmonic content added to the fundamental hence there is harmonic distortion therefore QA1 & QA2 =0.049.
· There is voltage unbalance as well as current unbalance as we can see from graph Va=220v Vb=237.6v Vc=220V (rms) & Ia=22A ,Ib=23.76A, Ic=22A (rms) even though load connected to source is balanced resistive load i.e., Ra=10Ω ,Rb=10Ω, Rc=10Ω because source is unbalanced hence QA3=0.0259 & QA4=0.0204.
· There is no phase displacement between voltage and current waveforms as the load is resistive load which is linear in nature therefore QA5=0.
· From above results we can calculate PQF from definition taking weighting factors as 0.2 hence PQF=0.969 which has been verified with hand calculation.
d) A balanced inductive load connected an unbalanced three-phase non-sinusoidal voltage source
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Fig 6.4 Front Panel presenting PQF for an unbalanced inductive load and unbalanced three phase non-sinusoidal source
OBSERVATIONS:

· Both voltage and current waveforms are non-sinusoidal as there is 5% of fundamental fifth harmonic content added to the fundamental hence there is harmonic distortion therefore QA1 & QA2 =0.05.
· There is voltage unbalance as well as current unbalance as we can see from graph Va=220v Vb=237.6v Vc=220V (rms) & Ia=22A,Ib=11.88A, Ic=22A (rms) as load connected to source is inductive load i.e., Ra=Rb=Rc=10Ω & La=Lb=Lc=10mH hence QA3=0.0259 & QA4=0.307.
· There is a phase displacement between voltage and current waveforms as the load is inductive load hence current lags voltage by 17.44 deg as per connected load therefore QA5=0.10466.
· From above results we can calculate PQF from definition taking weighting factors as 0.2 hence PQF=0.892 which has been verified with hand calculation.
RESULTS:

By analyzing the results that are obtained from above four different cases observation can be made that PQF will degrade more when all the three quality aspects occur simultaneously. With the help of the resonant passive RLC harmonic filtering technique [15], the PQF is improved.
6.2 DETECTION OF ELECTIRC DISTURBANCES

Electrical disturbances such as Voltage Sag, Voltage Swell, Interruption, Frequency Change, no. of impulses that have occurred and its amplitude and location, Harmonic Distortion content in the signal are detected successfully with virtual instrumentation concept. In this case an input supply of 10Vp-p is considered as normal standard compared to 220Vrms in general. According to the definitions of above mentioned disturbances that are discussed in section 1.1 programming is developed in section 5.1.5 and the result for various disturbances are displayed on front panels as shown below. When the input supplied is 10Vp-p, 50 Hz frequency i.e., normal condition there is no indication for any disturbances which can be shown below:
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Fig. 6.5 Front Panel presenting Acquired Waveform without any disturbances
When the input supplied is less than 10Vp-p, 50 Hz frequency i.e., if the rms value falls within the range 0.1 to 0.9 of nominal rms value, then it indicates disturbance as voltage sag which is 
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Fig. 6.6 Front Panel indicating Voltage Sag disturbance in Acquired Waveform
When the input supplied is more than 10Vp-p, 50 Hz frequency i.e., if the rms value falls within the range 1.1 to 1.8 of nominal rms value, then it indicates disturbance as voltage swell which is as shown below
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Fig 6.7 Front Panel indicating Voltage Swell disturbance in Acquired Waveform

When the input supplied is 10Vp-p, and if frequency deviates from 1% of nominal value, then it indicates disturbance as frequency change which is as shown below
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Fig 6.8 Front Panel indicating Voltage Sag and Frequency change disturbance in Acquired Waveform
When the input supplied is less than 0.1% of 10Vp-p, then it indicates disturbance as interruption which is as shown below
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Fig 6.9 Front Panel indicating Interruption disturbance in Acquired Waveform
CONCLUSION AND SCOPE FOR FUTURE WORK

An integral assessment of the power transfer quality of a three-phase network by means of a new indicator (i.e., PQF) has been suggested. The PQF takes into consideration various quality aspects (QA’s), notably, the current and voltage harmonic levels, the phase displacements between corresponding phase voltages and currents at the fundamental frequency, and the degree of unbalance in the different phase voltages and currents. The measurement of the PQF offers the convenience of assessing than measuring a multitude of factors and comparing them with their respective recommended values. The different quality aspects (QA’s) are, however, distinctly indicated so that specific quality aspects that need correction can be readily identified. Moreover, by selecting appropriate weightings, the new quality factor can be adapted to different economic objectives and load environments. The applicability of the PQF is illustrated for typical source–load configurations. The simplicity offered by the new factor allows the development of efficient rate structures and eventual enforcing policies that aim at enhancing the power quality of the mains and its reliability. The subject needs further research, such as detailed sensitivity evaluations of the PQF to the different parameters that affect the quality aspects and the development of a method that equitably allocates the responsibility of harmonics pollution between the utility and consumers [18]. The PQF takes into consideration various quality aspects (QA’s), notably, the current and voltage harmonic levels, the phase displacements between corresponding phase voltages and currents at the fundamental frequency, and the degree of unbalance in the different phase voltages and currents which can be expanded to include additional power-quality aspects (QAs) such as voltage sags, voltage swells, no. of impulses occurred, interruptions, under voltage, over voltage , flicker adequately defined in terms of their frequency and/or amplitudes. Monitoring of Power Quality using ADVANTECH DAQ CARD is successfully implemented, and has been tested by applying various disturbances with the help of function generator (by changing voltage knob and frequency knob). Verification also done with oscilloscope whether the acquired signal is matching with the given input signal. It can be performed in real time with the help of three voltage and three current transducer and whose output will be given to Screw Terminal Board PCLD-8710, due to its special PCB layout passive components can be installed to construct signal-conditioning circuits. Hence low-pass filter, attenuator or current shunt converter can be constructed by adding resistors and capacitors onto the board circuit pads from where signal is sent to PCI -1711 Multi Function Card and then the signal is analyzed using LabVIEW software.
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